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Introduction
Thank you for choosing WordSmith!

WordSmith is the most revolutionary, intuitive and full-featured word processor, doc viewer and enhanced memo pad available
for  the  Palm organizer.  WordSmith  synchronizes  and  integrates  seamlessly  with  Microsoft  Word  so  that  your  desktop
documents can easily be transferred to your organizer and vice a versa with little or no change in formatting!

In keeping with the application’s simple and extremely user-friendly interface, this manual strives to deliver the information you
need to know in as simple and straightforward a manner as possible.  The following is an overview of the manual:

Chapter 1 covers the features and systems requirements of WordSmith.  

Chapter 2 is a “Getting Started” chapter that covers installation, the basics of editing and viewing documents and memos
on your organizer, synchronizing documents between your desktop computer and organizer and MORE...  

Chapter 3 explains how the WordSmith conduit and converter works its magic.

Chapter 4 provides an overview of the WordSmith application - the word processor, document viewer and enhanced memo
pad.

Chapters 5-7 cover the numerous features embodied in this amazing little application feature-by-feature and menu-by-menu.  

Chapter 8 describes the numerous Graffiti and Palm Portable and Stowaway keyboard shortcuts available with WordSmith.

Chapter 9 provides general information, such as how to register and obtain technical support.  

Thanks again for using WordSmith.

The Blue Nomad Team

ã Blue Nomad, LLC
4 Hyde Street

Redwood City, CA  94062
www.bluenomad.com  

http://www.bluenomad.com/


Table of Contents

INTRODUCTION..................................................................................................................................................... I

FEATURES AND REQUIREMENTS.......................................................................................................................I

OVERVIEW OF FEATURES........................................................................................................................................ I

NEW FEATURES ON THE HORIZON.......................................................................................................................... II

SYSTEM REQUIREMENTS.......................................................................................................................................3

GETTING STARTED..............................................................................................................................................4

INSTALLING WORDSMITH......................................................................................................................................4

CREATE A NEW DOCUMENT IN WORDSMITH...........................................................................................................6

SYNC A NEW DOCUMENT TO WORD........................................................................................................................6

SYNC A WORD DOCUMENT TO WORDSMITH............................................................................................................7

OPEN AND EDIT THE DOCUMENT IN WORDSMITH....................................................................................................8

SYNC THE REVISED DOCUMENT TO WORD...............................................................................................................8

ENHANCED WORDSMITH MEMOS...........................................................................................................................9

VIEWING DOCUMENTS OR MEMOS..........................................................................................................................9

CUT, COPY, PASTE & MULTI-PASTE TEXT...............................................................................................................9

BOLD, UNDERLINE, ITALICS, SUPERSCRIPT  , SUBSCRIPT , STRIKETHROUGH  , COLOR FONTS & COLOR BACKGROUNDS...................10

FULL, LEFT OR RIGHT JUSTIFY OR CENTER TEXT..................................................................................................10

HOW TO DO OTHER REALLY COOL STUFF.............................................................................................................11

SYNCHRONIZATION AND CONVERSION..........................................................................................................13

INTRODUCTION................................................................................................................................................... 13

SYNCING DOCUMENTS TO YOUR ORGANIZER.........................................................................................................13

WordSmith Desktop...........................................................................................................................................................14
WordSmith Add-On to Microsoft Word Menu (Windows only)..............................................................................................17

2



OPENING WORDSMITH DOCUMENTS ON YOUR ORGANIZER AND YOUR DESKTOP.......................................................17

DISPLAY AND FORMATTING – WHAT IS LOST AND WHAT IS NOT..............................................................................18

SYNCHRONIZATION ACTION AND BACKUP COPIES..................................................................................................19

WORDSMITH COMMAND-LINE CONVERTER UNDER WINDOWS..................................................................................21

WORDSMITH ON LINUX/INTEL.............................................................................................................................21

WORDSMITH UNDER MACOS...............................................................................................................................22

WORDSMITH OVERVIEW..................................................................................................................................24

INTRODUCTION................................................................................................................................................... 24

MEMOS V. DOCS................................................................................................................................................24

EDIT MODE V. VIEW MODE.................................................................................................................................25

VIEWING LISTS OF YOUR MEMOS AND DOCS.........................................................................................................26

Memo/Doc List View Screen Features.................................................................................................................................26
Memo List View Screen Menus – Record, Edit and Options Menus......................................................................................28

Memo Record Menu..................................................................................................................................................28
Memo Edit Menu.......................................................................................................................................................29
Memo Options Menu.................................................................................................................................................29

Doc List View Screen Menus – File, Edit and Options Menus...............................................................................................31
Doc File Menu............................................................................................................................................................31
Doc Edit Menu............................................................................................................................................................33
Doc Options Menu.....................................................................................................................................................33

DOCUMENT EDITING........................................................................................................................................34

DOC EDIT MODE SCREEN FEATURES....................................................................................................................34

DOC EDIT MODE MENUS....................................................................................................................................36

Doc File Menu....................................................................................................................................................................36
Doc Edit Menu...................................................................................................................................................................40
Doc Format Menu...............................................................................................................................................................41
Doc Options Menu.............................................................................................................................................................44

MEMO EDITING................................................................................................................................................. 46

MEMO EDIT SCREEN FEATURES...........................................................................................................................46

MEMO EDIT MODE MENUS.................................................................................................................................47

Memo Record Menu...........................................................................................................................................................47
Memo Edit Menu................................................................................................................................................................50
Memo Format Menu...........................................................................................................................................................51
Memo Option Menu............................................................................................................................................................53

DOCUMENT VIEWING.......................................................................................................................................54

GENERAL VIEWING.............................................................................................................................................54

VIEW MODE MENUS...........................................................................................................................................56

GRAFFITI AND KEYBOARD SHORTCUTS..........................................................................................................57

GRAFFITI SHORTCUTS.........................................................................................................................................57

KEYBOARD SHORTCUT KEYS................................................................................................................................57

2



General Keyboard Shortcuts..............................................................................................................................................58
Text Selection Keyboard Shortcuts.....................................................................................................................................58

REGISTERING AND TECHNICAL SUPPORT...............................................................................................................60

REGISTERING.....................................................................................................................................................60

Site Licenses and Special Discounts..................................................................................................................................60
Updates & Email Address Changes....................................................................................................................................60

TECHNICAL SUPPORT..........................................................................................................................................61

Email Address Changes.....................................................................................................................................................61

2



3



2



Chapter

2



Features and Requirements

Overview of Features
 3 products in 1! Includes, a full-featured word processor, doc viewer and enhanced memo pad

 Seamless integration with Microsoft Word (Windows only)

 Command-line converters for Windows and Linux/Intel!

 Excellent keyboard support – supports full speed touch-typing and menu navigation without tapping!  Please see
Chapter 8 for more info

 Ability to print documents with PrintBoyÔ from Bachmann Software

 Cut, copy, paste, multi-paste, select all, undo, redo, find and More!

 Bold, underline, italics and color fonts – preserved and functional on your organizer!

 Beam, delete, duplicate, rename, save, save as, abandon changes and More!

 Paragraph formatting, such as setting page breaks, indents and line spacing!

 Fast compression of documents during HotSyncs and on demand

 Auto-scrolling, pen scrolling and special teleprompter style scrolling for easy viewing of documents

 Ability to synchronize documents to multiple computers!

 Word count and Font styles, sizes and color – preserved and adjustable on the organizer!  Even supports background
colors, superscript, subscript and strikethrough.

 Special “go to” feature lets you go to a character, paragraph or certain % of the document!

New Features on the Horizon

1
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This product is a work in process.  We plan on adding features rapidly over the next few months and year!  Please see below for
what is on our to-do list.  If you have additional features that you would like to see included, please let us know what they are by
emailing us at support@bluenomad.com.

Features for Future Releases

 Tabs

 Bookmarks

 More automated Find/Replace

 Support for automated bullets and numbering

 Footnotes and endnotes

 Email attachments

 More fonts

 Support for non-western languages (i.e., those that use multi-byte encoding)

Let us know what you want! If you have additional features that you would like to see included, please let us know what they
are by emailing us at support@bluenomad.com.
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System Requirements

WordSmith requires the following:

Palm Organizer and Palm Desktop Software
 Any Palm OS compatible organizer running Palm OS 3.0 or greater.  This includes Palm III-VII and m100, Sony Clie,

TRG devices and all Handspring devices.  Please note that WordSmith also runs fine when put in Flash memory by
JackFlash or FlashPro.

 Version 3.0 of HotSync or greater, available as a free upgrade from 3Com:  www.palm.com (and included in the
Desktop 3.0 upgrade, also available at the same website.

Desktop Computer 
 A desktop computer running one of the following operating systems:

o  Windows 95 with Internet Explorer 4.0 or better, 98, 2000 or NT4 with Service Pack 4 or better.

o Macintosh 68K or PowerPC Macintosh, running MacOS 7.5 or better

o RedHat Linux/Intel 6.0 or better

 A word processor capable of reading and writing Rich Text Format (“RTF”) files, e.g:

o Windows: Microsoft  Word  (Word  97  or  better  required  for  seamless  integration),  Microsoft  Works,
WordPerfect, AbiWord, WordPad

o MacOS: Microsoft Word

o Linux:: AbiWord, Star Office

3

http://www.palm.com/


7



8



Chapter

9



Getting Started

Installing WordSmith
To use WordSmith, you need to install Wordsmith to your desktop computer and organizer.  The instructions for
installation depend upon what type of  system you have.  Windows and Macintosh installation is covered
immediately below.

Windows Installation Instructions:

Step 1 Download the file WSSetup.exe to your computer (we recommend that you save it to the Windows
desktop).  

Step 2 Double-click on the resulting file to launch the installer.

Step 3 Follow the installer’s instructions.  

Once you have installed WordSmith, you should have a WordSmith icon on your desktop (if that is where you
saved it), WordSmith added as a menu in Microsoft Word (to the right of the Help menu but only if you are using
Word 97 or better) and a WordSmith application on your organizer. If you have trouble installing the application
or have forgotten your registration code, please visit  the support  center at  www.bluenomad.com for
assistance

Note regarding Optional Extra Large Font Installation

With Version 1.1 or better, during the installation process WordSmith will give you the
option of installing an extra large font to your organizer.  This extra large font will display
for text that is 20-point text or larger.  If installed, you will also be able to select this font
for text display in WordSmith documents.and memos.  To select the extra large text, from
the memo or doc list view screen open the Options menu and tap on Display Font and
select the extra large A.  .

Note Regarding Remapping Memo Pad Button as 
WordSmith Button

2
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During the installation of WordSmith, you are given the opportunity to remap the Memo
Pad button as the WordSmith button.  If at a later point you decide that you would like to
take us up on this, please tap Applications -> Preferences and then choose Buttons from
the pop-up menu in the upper-right.  Click on the arrow next to Memo Pad and select
WordSmith to remap.  If you would like to remap back to the Memo Pad, simply follow the
steps below except choose Memo Pad.

Note regarding WordSmith Menu in Microsoft Word 
(Windows only)

The WordSmith menu is added to Microsoft Word during the installation of WordSmith
(Windows only).  If would like to remove the add-on from Word, select the following:  Tools
-> Templates and Add-Ins and uncheck the box in front of WordSmith.dot.  To add the
WordSmith add-on, simply check the box described above.  Please note this feature is only
available for Word 97 or better.

Macintosh Installation Instructions:

Step 1 Download the file to your Macintosh and read the first 2 notes immediately above.

Step 2 After downloading the Stuffit self-extracting file, extract its contents using your favorite "unstuffing"
utility, such as Stuffit Expander.

Step 3 Install the WordSmith.prc to your organizer like you would any other application using the install tool
provided with the Palm desktop software.  

Step 4  Install the Macintosh conduit to your computer by copying the 
file name WordSmith Conduit  to the folder called “Conduits”,  which 
is located inside your Palm Desktop folder.  You may place the 
WordSmith application anywhere on your hard drive.
Step 5 (optional)  If you would like to use the unsupported document converter,  you may install it by simply
copying the document converter to the location of your choice on your Macintosh’s hard drive.

Really Getting Started…
Now that you have successfully installed WordSmith, let’s start editing docs and memos and reading (or
“viewing,” as they say)! This section steps you through:

 How to create a new document in WordSmith

 How to sync a new document to Word 

 How to sync a Word document to WordSmith 

 How to open and edit a document in WordSmith

 How to sync a revised document to Word 

 How to use the enhanced WordSmith Memo

 How to view documents or memos
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 How to cut, copy, paste and multi-paste text

 How to enter bold, underline, italics, superscript, subscript and strikethrough text

 How to full, left or right justify or center text

  How to do other really cool stuff

Create a New Document in WordSmith
To create a new document on your organizer, follow these simple steps:

Step 1 Tap on the WordSmith icon on your organizer to launch the application.

Step 2 Tap on the Doc Title Tab in the upper left hand corner (“Doc” should now be highlighted).

Step 3 Tap on the New button in the lower left hand corner; enter a name for your new doc and tap on the OK
button. 

Step 4 Enter text into your new document by using Graffiti, the onscreen keyboard or an external keyboard,
such as the Palm Portable or Stowaway keyboard.

Step 5 To close and save the new doc, tap on the Done button in the lower left hand corner. 

Sync a New Document to Word
To sync your new document to your desktop, follow these simple steps:

Step 1 Place your organizer in your HotSync cradle and press the HotSync button.

Step 2 Once the HotSync action is complete, the new document can be found in My Documents (Windows
users), the WordSmith folder inside your Palm user folder  inside the Palm desktop folder (Macintosh users) or
such other directory as you may have designated during the installation of  WordSmith or in  WordSmith
Preferences  (accessible  on  your  desktop  –  please  see  Chapter  3  for  more  information  on  the  desktop
application). You can open the document by doing any of the following:

 Open WordSmith on your desktop, select the document and double-click on it. 

 Open Microsoft Word and then click on the File menu and choose Open. Select the directory that your
document was saved in earlier (e.g., My Documents, if you are using the default set-up for Windows or
the WordSmith folder inside your Palm user folder inside the Palm desktop, if you are using the default
set-up for Macintosh) and open it like you would open any Word document.

 Open Microsoft Word and then click on the WordSmith menu (Windows only) and choose Open.

Note regarding WordSmith Synchronization Action 

Please note that by default the WordSmith conduit treats the document on your organizer
as the latest version of the document.  As such, the version of the document on your
organizer will trump the version on your desktop. Please see Chapter 3 - Synchronization
Action  and  Backup  Copies  for  important  information  regarding  synchronization  of
documents on your organizer with your desktop computer.
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Sync a Word Document to WordSmith
To take an existing Word document on your desktop and sync it to your organizer, follow these steps:

Step 1 Get the document ready for transfer to your organizer.  With WordSmith there are three easy ways to
do that:

 Open WordSmith on your desktop and drag-and-drop the document onto its window. 

 Open WordSmith on your desktop and use the Add button to browse for and select the document.

 Open Microsoft Word, click on the WordSmith menu and select Add.  The active Word document is
scheduled for synchronization. (Windows only)

Step 2 Place your organizer in your HotSync cradle and press the HotSync button.

Step 3 Once the HotSync action is completed, the document can be found in your list of docs in WordSmith
(tap on the Doc Title Tab in the upper left hand corner to see a list of your docs).

Note regarding WordSmith Synchronization Action 
Please note that by default the WordSmith conduit treats the document on your organizer
as the latest version of the document.  As such, the version of the document on your
organizer will trump the version on your desktop. Please see Chapter 3 - Synchronization
Action  and  Backup  Copies  for  important  information  regarding  synchronization  of
documents on your organizer with your desktop computer.

Open and Edit the Document in 
WordSmith
To open and edit the synced document on your organizer, follow these steps:

Step 1 Tap on the WordSmith icon on your organizer to launch the application.

Step 2 Tap on the Doc Title Tab in the upper left hand corner (if it is not already highlighted) and tap on the
name of the synced document to open it.

Step 3 Enter text to the synced document by using Graffiti, the onscreen keyboard or an external keyboard,
such as the Palm Portable or Stowaway keyboard.

Step 4 To close and save this doc, tap on the Done button in the lower left hand corner. 

Sync the Revised Document to Word
To sync the revised doc back to your desktop, follow the steps under “Sync a New Document to Word” above.

Note regarding WordSmith Synchronization Action 

13



Please note that by default the WordSmith conduit treats the document on your organizer
as the latest version of the document.  As such, the version of the document on your
organizer will trump the version on your desktop. Please see Chapter 3 - Synchronization
Action  and  Backup  Copies  for  important  information  regarding  synchronization  of
documents on your organizer with your desktop computer.

Enhanced WordSmith Memos
WordSmith comes with an enhanced memo pad.  Unlike the built-in memo pad, the WordSmith Memo has
better keyboard support and allows for rich text, such as bold, underline and
italics and most of the functionality available for WordSmith’s docs!

To use the WordSmith Memo, follow these steps:

Step 1 Tap on the WordSmith icon on your organizer to launch the application.

Step 2 Tap  on  the  Memo  Title  Tab  in  the  upper  left  hand  corner  (“Memo”  should  now  be
highlighted).

Step 3 Tap on the New button in the lower left hand corner and for your new memo or select from
an existing memo to revise. 

Step 4 Edit your memo by using Graffiti, the onscreen keyboard or an external keyboard, such as the
Palm Portable or Stowaway keyboard.

Step 5 To close and save the memo, tap on the Done button in the lower left hand corner. 

Viewing Documents or Memos
If all you want to do is read a document (e.g., e-book) or memo, simply follow these steps:

Step 1 Tap on the WordSmith icon on your organizer to launch the application.

Step 2 Tap on the memo or doc that you wish to view.

Step 3 WordSmith in View Mode. WordSmith is in View Mode if the button to the immediate right of
the Done button in the toolbar says View.  If it says Edit, tap on it to switch it to View. If you decide that you want
to edit text, just click on the View button to toggle it back to Edit.

Step 4 Tap on Done when you are finished to close the memo or doc. 

Cut, Copy, Paste & Multi-Paste Text
To cut, copy or paste, simply follow these steps:

Step 1 Launch WordSmith and select a doc or memo to edit.
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Step 2 Select text by tapping at the beginning of the first word of the 
text and dragging it to the end of the last word. Alternatively, you can 
quickly select a word by tapping and holding in the center of the 
word.  If you continue to hold, you can select the line of text and 
holding further will result in selecting the paragraph. Your selected 
text will now be highlighted. 

Step 3 Tap on the menu icon in the bottom left of your screen and 
select the Edit menu and then Copy or Cut.  Move your stylus to 
where you want to paste the selected text.  Then, open the Edit menu 
and select Paste or Multi-Paste*.  Please see Chapter 8 for information
on using graffiti shortcuts (e.g., CmdX, CmdC, CmdP and Cmd 8) and 
keyboard shortcuts (e.g., Ctrl+x, Ctrl+c, Ctrl+p and Ctrl+V). 
* Unlike standard paste, multi-paste allows you to do a paste of any 
of your last 10 'Cut' or 'Copy' commands from within a document.  
Just select multi-paste from the menu and a list appears with the 
beginning text of each 'Copy' or 'Cut'.  Select the one you want and it 
will be pasted into the document.  

Bold, Underline, Italics, Superscript, Subscript , 
Strikethrough, Color fonts & Color 
Backgrounds
To add rich text to your memos and docs, simply follow these steps:  

Step 1 Launch WordSmith and select a doc or memo to edit.

Step 2 You can enter new rich text or select* old text to be formatted. 
To turn bold, underline or italics on, you can click on the B, U or I  
buttons in the Toolbar.  Newly entered text will be in that style and 
selected text will change to that style. Tap on the button again to turn 
it off.  Alternatively, tap on the Font box to the right of the italics 
button.  From the Font dialog box, use the checkboxes to turn on and 
off bold, underline, italics, superscript, subscript and strikethrough or 
select a color for your font or background.  

Lastly, you can access all of these features by using the Format menu. 
To access this menu, tap on the Menu icon in the bottom left of your 
screen, select the Format menu and then Bold, Underline, Italics or 
Font.  Please see Chapter 8 for information on using Graffiti shortcuts 
(e.g., Cmd B, Cmd U, Cmd I and Cmd D) and keyboard shortcuts (e.g., 
Ctrl+b, Ctrl+u, Ctrl+i and Ctrl+d). 
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Please note that although you can select superscript and subscript in 
a doc, it will not display on your organizer (only on your desktop when
the doc is synched).

* Please see Cut, Copy, Paste & Multi-Paste above for instructions on 
how to select text.

Full, Left Or Right Justify Or Center 
Text
To change the formatting, follow these simple steps:

Step 1 Launch WordSmith and select a doc or memo to edit.

Step 2 Select text to be formatted. To select an existing 
paragraph for formatting, tap anywhere in the paragraph to select it. 
To select more than one paragraph for formatting, select text* as you 
normally would. To format new text, proceed to Step 3 and then enter 
text.

Step 3  Click on the justification button (to the left of the B button) in
the toolbar and select justification.  You can also change the 
formatting by tapping on the button to the right of the Edit button 
(note:  available in docs only). 

In addition, you can access all of these formatting options by using the
Format menu.  To access this menu, tap on the Menu icon in the 
bottom left of your screen, select the Format menu and then Left, 
Right, Center or Paragraph.  Please see Chapter 8 for information on 
using Graffiti shortcuts (e.g., Cmd L, Cmd R, Cmd C and Cmd H) and 
keyboard shortcuts (e.g., Ctrl+l, Ctrl+r, Ctrl+e and Ctrl+p). 

Please note that although you can select Full justification in a doc, it 
will not display on your organizer (only on your desktop when the doc 
is synced).

* Please see Cut, Copy & Paste above for instructions on how to select
text.

How To Do Other Really Cool Stuff
The following are a few examples of cool features that may not be readily apparent:

Pop-Up Menus In addition to WordSmith’s many pull-down menus, WordSmith also has some very
handy pop-up menus for stylus users.  For example, if you are viewing a list of your docs, you can access a pop-
up menu that lists the following: Edit, Beam, Delete, Duplicate, Rename, Category, Print and Details (a slightly
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different pop-up menu will appear for memos).  You can access the pop-up menu by tapping and holding
anywhere on the listed doc or memo. 

Similarly, if you are editing a doc, a pop-up menu that lists the following: Cut, Copy, Bold Underline, Italics,
Strikethrough, Larger, Smaller, and Font is available.  You can access this pop-up menu by tapping and holding
to select a word then releasing, and tapping and holding on the selected word again.  A similar pop-up menu is
also accessible while editing memos.

Tapping to Select Words, Sentences or Paragraphs   With WordSmith you can
quickly select a word by tapping and holding in the center of the word.  If you continue to hold, you can select
the full sentence and holding further will result in selecting the paragraph. 

Multi-Paste Unlike standard paste, multi-paste allows you to do a 
paste of any of your
last 10 'Cut' or 'Copy' commands within a document.  Just select multi-paste from the menu and a list appears
with the beginning text of each 'Copy' or 'Cut'.  Select the one you want and it will be pasted into the document.

Go to Paragraph This nifty go-to option opens a box that lists the first few words of each paragraph in your
doc or memo. Select the paragraph you want to jump to by clicking on the beginning of the listed paragraph in
the box.  Use the arrows in the upper right hand and lower right hand corner of the box  to move through all of
the listed paragraphs.  To close this feature, simply tap outside of the box.

Print Your Document or Memo This option lets you print your document if you have a supported print
utility  such  as  Bachmann  Software’s  PrintBoy  installed.   For  more  information  on  PrintBoy,  visit
www.bachmannsoftware.com.

Special Security Options These nifty options let you set the security level for your organizer and the
security level for WordSmith.  Please see chapter 4 for more information.

Other Cool Stuff Please see Chapters 4-8 for descriptions of other cool features and instructions on how to
get the most out of this application.
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Synchronization and 
Conversion

Introduction

WordSmith’s synchronization technology is based upon the same technology that has made BackupBuddy &
InstallBuddy such popular and easy to use products (available from www.bluenomad.com). WordSmith
comes with a Windows and Macintosh conduit that allows you to synchronize your Microsoft Word documents
and other RTF documents to your organizer, edit them and then send the revised document back to your
desktop with little or no loss to the document’s original formatting!  In addition, for Linux users, WordSmith
ships with a Command-line document converter.  This chapter describes how to use the conduits and the
Command-line document converter.  

Note regarding WordSmith Synchronization Action 
Please note that by default the WordSmith conduit treats the document on your organizer
as the latest version of the document.  As such, the version of the document on your
organizer will trump the version on your desktop. Please see Synchronization Action and
Backup Copies (below) for important information regarding synchronization of documents
on your organizer with your desktop computer.

Syncing Documents to Your Organizer
This section of the manual describes how to use WordSmith to synchronize documents to and from your
computer.

WordSmith makes it very easy for you to synchronize your documents to your organizer.  First you need to let
WordSmith know which documents to synchronize and then all you need to do is HotSync!

There are 2 ways to let WordSmith know what documents to synchronize:  (1) through the WordSmith desktop
application and (2) through the WordSmith add-on menu in Microsoft Word (Windows only), if you have Word.

3
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Note for non-Microsoft Word Users
Please note that since WordSmith works directly with RTF files, you don’t actually need
Microsoft Word to use it.  You can use any RTF editor on your computer, including
WordPad, WordPerfect, etc.  Simply save your document as an RTF file and add it to the
WordSmith desktop application per the instructions below.

WordSmith Desktop

The WordSmith desktop application is very similar in form to your organizer’s default installation tool.  In
addition, the Windows and Macintosh versions are very similar.  Unless otherwise described the instructions
below apply to both versions. 

To launch WordSmith desktop:

 Windows version.  Click on the Window’s Start Button -> Programs -> WordSmith or click on your
WordSmith shortcut icon, if applicable.

 Macintosh version.  Double click on the WordSmith application.

When you open the WordSmith desktop window, you will see the list of documents that are being synchronized
with your handheld on your next HotSync (first screenshot is from the Macintosh version, second is from the
Windows version). 

To  add documents  to
the  WordSmith synchronize
list, you  can  use the  Add…  button
to  browse  for  the document
(described  below) or  simply  drag-
and-drop the document onto the
WordSmith window. The  following
describes  the features  of  this
window.

User  Select  your Palm username by
using the  arrow to the  right  of  the
User name box. 

Document Name Clicking  on  the
document name will cause  its
properties  to appear  in  the
Document Properties box (described below, Windows only) and will select the document.  Double-clicking on the
document name will open the document on your desktop.  Lastly, if you right click on the document name, you
will see a menu that gives you the following options:  Open, Move, Remove, Print, Open Original*, Open
Backup* and Explore (Windows only).  

* Open Original and Open Backup refer to copies of the document that were made when the document was first
synchronized after being edited on the handheld and when the document was edited on the handheld and on
the desktop, respectively.
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Note regarding WordSmith Synchronization Action, 
Originals and Backup Copies 

Please note that by default the WordSmith conduit treats the document on your organizer
as the latest version of the document.  As such, the version of the document on your
organizer will trump the version on your desktop. Please see Synchronization Action and
Backup Copies below for important information regarding synchronization of documents
on your organizer with your desktop computer.

Document Properties When you select a document (by clicking on the document’s name in the above box),
the location of the document on your desktop, the Palm category of the application (e.g., All, Unfiled, Business,
etc.) and the date and time the document was last synchronized with your organizer is displayed in the bottom
portion of the window.  (Windows only)

Size Shows the size of document, if available.  (Windows only) Before a document is synced, the size will be
Unavailable.

Add… Click on the Add button to add documents to WordSmith for synchronization with the organizer.  When
you click on Add, you will be prompted to select a username and then a window will open and allow you to
browse for a document to add.  Simply select the document and click on Open.  The document should now be
listed in the WordSmith window. 

Remove To remove a document from the WordSmith document list, select the document name and click on the
Remove button.  In addition, if the document has been synchronized, selecting this feature will give you the
option of having WordSmith delete the document on your organizer.  Alternatively, you may select the document
name, right click and then click on Remove in the context menu.

Move… To move a document (and its original and backup copy, if applicable (please see Synchronization
Action and Backup Copies below for more information)) from one location to another, select the document name
and click on the Move button.  WordSmith will bring up a list of destination folders for the document (Windows
version) or window that you can use to select the destination directory (Macintosh version).  Click on the folder
you want and then click on the OK or Choose button.  The document will now be moved to the location selected.
Alternatively, you may select the document name, right click and then click on Move in the context menu.
(Windows only).  

Preferences… Currently, the Preferences screen provides you with the following options.  
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First, the Preferences screen allows you to change the default directory into which documents created on your
organizer are saved when they are synchronized to your desktop computer.  By default these documents are
synchronized to your My Documents folder (for Windows) or in the WordSmith folder in the Palm user folder
inside the Palm desktop folder (for Macintosh) on your desktop.  You can hit the Choose button to select a
different location for these files to go.  The WordSmith Preferences dialog box also lets you choose what file
extension you would like these files to have (Windows only).  Currently, the choice is .doc or .rtf.  For those of
you who are using word processors other than Microsoft Word, .rtf is the most appropriate choice.  Lastly,
WordSmith allows you to preserve the  stylesheets  of  documents  created on your organizer.   By default,
WordSmith is not set up to preserve these stylesheets for performance reasons (they would require a lot of
memory on your organizer).  To change the default option to “Always” preserve stylesheets, simply click on the
pull-down arrow to the right of the box.

Help Click on the Help button to access the WordSmith manual. (Windows only)

Done or Quit Click on the Done or Quit button to close the WordSmith window.

WordSmith Add-On to Microsoft Word Menu (Windows only)

If you are already in Microsoft Word, using the WordSmith add-on menu in Word may be the easiest option for
you to prepare documents for synchronization (Windows only).  If you have a document open that you want to
synchronize with your organizer, all you need to do is select WordSmith -> Add.   
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Note regarding WordSmith Menu in Microsoft Word 
(Windows only)

The WordSmith menu is added to Microsoft Word during the installation of WordSmith.  If
would like to remove the add-on from Word, select the following:  Tools -> Templates and
Add-Ins and uncheck the box in front of WordSmith.dot.  To add the WordSmith add-on,
simply check the box described above.

Opening WordSmith Documents on 
Your Organizer and Your Desktop
To open a synchronized document on your organizer is a breeze… All 
you need to do is launch WordSmith, select the Doc Title Tab and tap 
on the name of the synchronized document.  It will quickly open. 
Opening the document on your desktop is just as easy.  Once again, 
you have a couple options:

 From within the WordSmith desktop application, simply double 
click on the document name and it will open.

 Using the WordSmith add-on menu in Microsoft Word (Windows 
only), select WordSmith -> Open to open the WordSmith list of 
documents. Simply double click on the document name and it 
will open.

 Open the document like you would any other document on your 
desktop.  For example, if you chose to have docs created on your
Palm go to My Documents, open My Documents to open your 
document.

Display and Formatting – What is Lost 
and What is Not
WordSmith is capable of preserving all of the below:

Fonts Name*, size*, color,** bold, underline, italics, superscript*, subscript* and strikethrough

Justification left, right, center and full*

Indents   first, hanging, left and right

Page breaks and outline levels*

Keep lines together* and keep with next paragraph*
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Spacing (inter-paragraph) before and after

Spacing (intra-paragraph) single, double, etc.!

RTF document properties (information) – you can access this in Word by selecting Properties under the
File menu

*Except for items with an * or ** after them, WordSmith is capable of displaying all of the above on your
organizer.   

**Color organizer required for display on your organizer.

Currently, WordSmith does not display or preserve: tables, objects, pictures, database links and inter-document
links on your organizer.

Synchronization Action and Backup 
Copies
This section describes how the synchronization actually works.  For purposes of illustration, let’s assume that
you have a document on your desktop called “Poetic License.”  When WordSmith synchronizes Poetic License to
your organizer, nothing happens to the copy of Poetic License on your desktop.  Poetic License will only be
altered on your desktop if you edit and save Poetic License on your organizer and then synchronize the revised
doc back to your desktop. At this point, WordSmith will create the following 2 files on your desktop:

 Poetic License.doc (or Poetic License.rtf, if you are a Macintosh user)  -the revised
document that you just synchronized from your organizer to your desktop and

 Poetic  License-orig.doc (or  with  the  .rtf  extension  if  you  are  a  Macintosh  user  or
depending upon how you have set WordSmith Preferences (Windows users)) – this is a copy
of your unedited, original of Poetic License.

In the event of a “collision,” a situation where you have not only edited Poetic License on your organizer but
also on the desktop, WordSmith will conclude that the version on your organizer is the most recent version.  In
this case, WordSmith will make a copy of the revised document on your desktop and call it Poetic License-
back.doc (or .rtf).

The Poetic License -orig.doc (or .rtf) and Poetic License -back.doc (or .rtf) files are saved in the same location as
the original Poetic License doc was saved.

To override the above synchronization actions, use the standard HotSync Custom dialog.  For Windows users,
you can access this by clicking on the red and blue HotSync icon in the rightmost corner of your traybar and
selecting Custom and then WordSmith or clicking on Windows Start -> Programs -> Palm Desktop -> HotSync -
> Custom.
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For information about the Synchronize the files option, please see above.  Desktop overwrites handheld copies
all files from your WordSmith desktop’s file list to your organizer (this action will replace the files on your
organizer with the ones from your desktop).

Handheld overwrites desktop causes all documents on your organizer to be placed in the directory you selected
for WordSmith and overrides the files that are there.  Do nothing turns off synchronization of your WordSmith

files.

Word
Smith

Command-line converter under 
Windows
In addition to the conduit, advanced Windows users may use an ms-
dos command-line program for converting WordSmith documents to 
and from the RTF format. 

Please note:
1. This program is for advanced users only and is not currently 

supported under Windows
2. The application currently only converts to and from RTF files.  

It will not convert a source document that is not RTF.  If you 
wish to do so, we recommend using makedoc or a similar 
utility.

Usage:
WSConv [-n] [-ps] <input file> <output file> <title>:
Converts an RTF file to WordSmith's rich document Palm “PDB” 
format.
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[-n] builds the Palm file without compression.  
[-ps] preserves document stylesheet, if any.

All fields are required except “-n” and “-ps”, which are optional.

WSConv -d <input file> <output file>
Converts WordSmith rich document PDB to RTF format.  All fields are 
required.

WordSmith on Linux/Intel
Since Linux does not support a standard HotSync conduit API, such as
the one available under Windows and MacOS, we are not currently 
able to offer conduit support for Linux.  

Nonetheless, we have provided a shell-based conversion application 
called wsconv for converting to and from RTF documents.  If you are 
looking for a high-quality and free word-processor for Linux that is 
able to read and write RTF files, we recommend AbiWord 
(http://www.abiword.com).

Please note:
1. The application currently only converts to and from RTF files.  It

will not convert a source document that is not RTF.  If you wish 
to do so, we recommend using makedoc or a similar utility.

2. The application was compiled under RedHat Linux/Intel 6.0 and 
should work with any later release of RedHat Linux.

3. Source code for the application is not available at this time.  If 
you are using a different Linux distribution, or a UNIX variant 
and are not able to run the conversion application, please 
contact support@bluenomad.com.

Usage:

Using wsconv under Linux is similar to that under Windows.  Please 
refer to the description above.

WordSmith under MacOS
With the release of the Macintosh conduit for WordSmith, we are no 
longer supporting the stand-alone document converter for Macintosh. 
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The stand-alone application converts RTF documents to WordSmith’s 
Palm PDB format, and converts WordSmith’s Palm PDB files back to 
RTF documents. 

Please note: 
1. The application currently only converts to and from RTF 

documents.  It has been tested with Microsoft Word, but not 
other MacOS word processors.  This means that if you have a 
Word document that you would like to convert, you should save 
it as an RTF file, via Word’s “Save As…” command under the 
Word “File” menu.

2. The application should work with any 68K or PowerPC 
Macintosh, running MacOS 7.5 or better; however, it has only 
been tested under MacOS 9 running on a PowerPC Macintosh.  

3. The application does not currently support drag-and-drop 
operations or the Appearance Manager.

Usage:

1. Launch the WordSmith Document Converter application by 
double-clicking its name in the Finder.  

2. To convert a document, click the Convert button, and navigate 
to the file you want to convert.  If the file is an RTF document, 
you will be prompted to save it as a Palm PDB file.  If the file is a
Palm PDB file (ie. ends in “.PDB”), you will be prompted to save 
it as a Word RTF document.

3. To enable the preservation of stylesheets, check the 
“preserve stylesheet” box in the lower portion of the dialog box 
(not shown above). 

4. If you converted an RTF document to a Palm PDB file, you can 
use the Palm Install tool that came with your MacPac/HotSync 
software to install the file to your Palm.  If you are unsure of 
how to do that, please refer to the documentation that came 
with the MacPac software, or visit http://www.palm.com for more 
information.  If you converted a Palm PDB file to an RTF 
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document and you have Microsoft Word installed on your 
Macintosh, you can now edit the file by double-clicking it in the 
Finder.

Locating Palm PDB Files to Convert:

1. Navigate to the folder into which you installed the 
MacPac/HotSync software.

2. Open the “Users” folder
3. Locate and open your Palm’s data folder – it will be a variation 

on your Palm User Name.  For example, if your Palm User Name
is “Joe Smith”, your Palm’s data folder would be called “JSmith”.

4. Locate and open the Backup folder inside your Palm’s data 
folder.  WordSmith document files that exist on your Palm can 
be found inside this folder.
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WordSmith Overview 

Introduction

As mentioned above, WordSmith is not only a document editor but also an enhanced memo pad and document
viewer.  This section briefly covers the differences between the WordSmith memos and docs and the Edit Mode
and View Mode of WordSmith.  In addition, it covers some basics, such as understanding WordSmith’s memo
and doc list views (the screens that list all of your memos or docs (the “List View Screen”)) and organizing and
accessing more information about your memos and docs. Lastly, the pull-down menus that are accessible while
you are in a List View Screen are also described below.  

Note Regarding Coverage of WordSmith Pull-Down 
Menus in this Manual

After spending a few minutes playing around with WordSmith, you will see that it is an
incredibly feature-rich and menu-rich application.  To help you understand what the menu
items refer to we have split up coverage of the menus as described below:  

Doc and Memo List View Screen Menus – Chapter 4

Doc Editing Menus – Chapter 5

Memo Editing Menus – Chapter 6

Doc and Memo Viewing Menus – Chapter 7

4
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Memos v. Docs 
When you launch WordSmith on your organizer, you are given the option of working with  memos or docs.  You
can toggle between memos and docs by clicking on the Memo or Doc Title Tab at the top of the WordSmith list
view screen.

WordSmith memos and docs have many of the same menu options and functionality.  In general, memos are
good for short notes, to-do lists and other material that doesn’t necessarily need to be synced to your desktop.
(In WordSmith, memos lose formatting when they are synced to your desktop.  If you do decide that you want to
sync a memo with your desktop, select Save as Doc and then sync it to your desktop.)  Docs, on the other hand,
are good for longer letters, papers and reports.  Another major difference between docs and memos is that
memos have a 4,000-character limit and do not have some of the formatting features that are available with
docs.  Lastly, when you close a doc and reopen the doc, WordSmith remembers where you were in the doc and
whether you were in Edit Mode or View Mode.  WordSmith memos do not have this capability at this time.

WordSmith memo is vastly improved over the built-in memo pad on your organizer.  For example, it supports
rich text (i.e., bold, underline and italics), formatting, such as right and left justification and centering and the
Palm Portable and Stowaway keyboard like no other application!  Take a few minutes to check it out (see below
for basic menu items and for additional menu items see Chapter 6.

Note Regarding Remapping Memo Pad Button as 
WordSmith Button

During the installation of WordSmith, you are given the opportunity to remap the Memo
Pad button as the WordSmith button.  If at a later point you decide that you would like to
take us up on this, please tap Applications -> Preferences and then choose Buttons from
the pop-up menu in the upper-right.  Click on the arrow next to Memo Pad and select
WordSmith to remap.  If you would like to remap back to the Memo Pad, simply follow the
steps below except choose Memo Pad.

Edit Mode v. View Mode
When you launch WordSmith on your organizer and open a memo or doc, you are given the option to edit or
view it.  WordSmith is in View Mode if the button to the immediate right of the Done button in the toolbar says
View.  If it says Edit, it is in Edit Mode.  You can toggle between Edit Mode and View Mode by tapping on this
button at any time.

In Edit Mode you are provided with tools for editing and formatting text.  In View Mode , on the other hand, you
are protected from making unwanted changes to the text that you are viewing.  In addition, in View Mode there
are some handy scrolling features that permit you to auto-scroll, etc.  For more information on these scrolling
features, please see Chapter 7. 

33



Viewing Lists of Your Memos and Docs
When you launch WordSmith, you will see a list of all of the memos (if you have Memo selected) or the Docs (if
you have Doc selected) that are available on your organizer to view or edit. Each list may be categorized, filtered
and organized as described below.  In addition, on the memo or doc list screen (shown below), there are 2
menus that allow you to perform a number of operations with the listed memos and documents, including beam,
rename, delete, etc.  For memos, there are 3 menus: Record, Edit and Options menu. Likewise, docs have a File,
Edit and Options menu. For more information on the List Screen and these menus, please see below.

Memo/Doc List View Screen Features

Pop-Up Menus In addition to WordSmith’s many pull-down menus, WordSmith also has some very
handy pop-up menus for stylus users.  For example, if you are viewing a list of your docs, you can access a pop-
up menu that lists the following: Edit, Beam, Delete, Duplicate, Rename, Category, Print and Details (a slightly
different pop-up menu will appear for memos).  You can access the pop-up menu by tapping and holding
anywhere on the listed doc or memo. 

Memo/Doc The Memo/Doc Title Tab lets you chose whether you want to be in a memo or doc.  To use
memos, tap on the word Memo in the Title Tab.  Alternatively, tap on Doc in the Title Tab to choose docs.
Whichever word is highlighted indicates which mode you are in.

Categories Like many Palm programs, WordSmith helps you stay organized by letting you assign your
memos and documents to categories.  WordSmith has the following default categories for memos and docs:  All,
Business, Personal and Unfiled.  In addition, WordSmith lets you add to and edit these categories for both.
WordSmith allows you to have up to 16 categories (including Unfiled) for
each!  
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Edit Categories By tapping on Edit Categories, you will bring up the Edit Categories dialog
box shown below.  This dialog box allows you to add new categories and rename or delete existing
categories. Please note that you can have different categories for memos and docs and that categories
changed in one mode are not automatically changed in the other.

New To create a new category, tap on the New button and enter a new category name
when prompted and then tap OK.

Rename To rename an existing category, simply select the category name you wish to
rename, click on the Rename button, enter the new category name and then tap Ok.

Delete To delete an existing category, simply select the category name you wish to
delete, tap the Delete button and then tap OK to exit the Edit Categories dialog box.

Memo or Doc Name To open the memo or doc, simply tap on its name.

 To  the  left  of  each  WordSmith  document  (i.e.,  a  document  that
contains rich text, such as bold, italics or underline) is a small W icon.  If
you tap on the W icon, it will bring up the pop-up menu. 

Doc Size To the right of each document name is a number that represents the size of the file.  Please note
that this feature is not available for memos.

Doc Type To the left of each document that contains rich text (i.e., a WordSmith doc), you will see a small
W icon. 

New To create a new memo or doc, simply tap on the New button.  When you create a new doc, you will be
prompted to enter a name for the new doc.  

Register To register, simply tap on the Register button and enter your registration code.   Please note that
once you have registered, this Register button will disappear.

Filter:……………If you have many memos or docs, this filter feature may save you a lot of time.  Rather
than scroll through all your memos or docs looking for the doc titled Zoology, you can use this feature to quickly
see all memos or docs that start with the letter Z or Zoo or Zoology.  Simply input the text that you want to use
to filter (e.g., Z, Zoo or Zoology) by inputting it to the right of the word Filter and the filtering will automatically
begin.
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Free:…k Once you have registered WordSmith, the Register button disappears and this option becomes
enabled.  This option simply tells you how much free memory you have available.

Memo List View Screen Menus – Record, Edit and Options Menus

To view these menus, launch WordSmith, tap on the Memo Title Tab and then click on your organizer’s Menu
icon.

Memo Record Menu
The Record menu for WordSmith memos has the following options:

Beam Category…  This option will allow you to beam the category of memos (e.g., All, Business,
Personal, etc.) that you have selected on your Memo List View Screen.  For example, if the screen shows All
memos, selecting this option will beam all of your memos. 

Beam WordSmith…  Beam WordSmith to a friend.  Please note that this will  only beam an
unregistered version of the application.

Beam Memo…  This option will let you beam the memo that you have selected (highlighted).

Delete Memo…  This option will let you delete the memo that you have selected (highlighted).  When
you select this option, a dialog box will ask you whether you want to save an archive copy on your PC.  To enable
this archive option, simply tap on the Save archive copy on PC box and tap on OK.

Duplicate Memo  This option will let you duplicate the memo that you have selected (highlighted).
Edit the first few words of the memo to change the name of the duplicated memo.

Details…  Tap on Details to open the Memo Details dialog box. This Details dialog box indicates what
category the memo is saved under and allows you to change the memo category by clicking on the arrow to the
left of the category name.  In addition, by checking the Private box, you can make this memo private or masked
(i.e., hideable). You may also delete a memo by tapping the Delete button.

Select Memo  This option explains how to select memos and that to select a memo without opening it,
you can hold down the stylus over the memo name until the popup menu shown below appears. 
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Memo Edit Menu
The Edit menu for WordSmith memos has the following options: 

Undo, Cut, Copy, Paste and Select All  These standard Edit options allow you to edit
text for use in the Filter only.  For example, if you copy a name from a document or another application, you can
simply paste it into the Filter and quickly view the memos that have the selected name in the title.  

Keyboard  Tapping on Keyboard will bring up the onscreen keyboard on your organizer.

Graffiti Help  This option provides you with a list of all of the Graffiti characters.

Memo Options Menu
The Option menu for WordSmith memos has the following features: 

Table Font…  Select the font size for the text in the List View Screen by tapping on the size you want
(e.g., small, normal or large).  This font will then be applied to the memo and doc list.

Display Font… Select the font size for the text of your Memos and Docs by tapping on the size you
want  (e.g., small, normal, large or extra large (if you have opted to install the extra font set during installation)).
For color organizers, you can also set text and background color from this dialog box. This font will then be
applied to all of the memos and docs in WordSmith.

Preferences…  This option allows you to select how your memos are listed on the List Screen , to
change the highlight color (available to certain newer and color models only), to enable left-handed support and
to turn on or off smooth scrolling (turning off smooth-scroll will result in line by line or “jerky” scrolling).  The
default sorting mode is Alphabetic.  To change the ordering to manual (so you can sort them), tap on the arrow
to the left of Alphabetic, tap on Manual and then OK.  To enable the other options, merely check or uncheck the
associated check box.

Security…  This dialog box, which is also accessible from the doc Options menu, allows you to set your
security preferences for WordSmith.  If enabled, these preferences will become your minimum security settings
for WordSmith.  In other words, if your handheld’s security is set to a higher standard, then the higher standard
will apply.  If your handheld’s security is not set or is set to a lower level, then the setting you have selected for
WordSmith will trump.  For more information about your handheld’s security options, please refer to your
handheld’s documentation.
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WordSmith comes with 2 security timer options.  The first enables you to set a timer to password protect
WordSmith. For example, if you want WordSmith to require that you provide a password after a certain period
of time, check the Require password after ___ box.  To require a password upon start-up of WordSmith, set the
time to 0 minutes.  Also, you can set WordSmith to automatically increase its security level.  For example, you
can set WordSmith to automatically mask or hide all private records after a certain amount of time has passed
(minutes, hours or days).  Lastly, for your convenience, you can elect to show, mask or hide private records from
this screen by using the Show/Mask/Hide push buttons.

Please note that masked records (records that have been replaced with gray placeholders as opposed to hidden
records that are deleted from the screen) are generally supported by devices running Palm OS 3.5 or better.
Nevertheless, users of devices running Palm OS 3.0 or better will be able to mask records within WordSmith
with this feature!  

Register…  This option allows you register a trial version of WordSmith.  Simply tap on Register and
input the information requested on the Register dialog box.  For more information on registering, please see
Chapter 9.

About…  Select About to see what version of WordSmith you are running.

Doc List View Screen Menus – File, Edit and Options Menus

Doc File Menu
The File menu for WordSmith’s docs has the following options:

Beam WordSmith…  Beam WordSmith to a friend.  Please note that this will only beam an unregistered
version of the application.

Beam Doc…  This option will let you beam the doc that you have selected (highlighted).

Delete Doc…  This option will let you delete the doc that you have selected (highlighted).  Please note that
this option will delete the document from your handheld but not from the desktop.

Duplicate Doc…  This option will let you duplicate the doc that you have selected (highlighted) and enter a
new name for the duplicated doc.  

Rename Doc…  This option will let you rename the doc that you have selected (highlighted).  

Print Doc…  This option will let you print your WordSmith doc with the assistance of a supported printing
utility, such as PrintBoy by Bachmann Software (www.bachmannsoftware.com).
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Details…  Tap on Details to open the Details dialog box shown below.  

This dialog box provides (1) certain general information on the doc and provides you the opportunity to
change certain attributes of the doc and (2) compression information.  With the General Title Tab
selected, you will have the following options:

Name   Indicates the current name of the document.  You may change the name by inputting a new
name and clicking OK.

Category   Shows the category the doc is saved under and allows you to change the category by
clicking on the arrow to the left of the category name.  

Sync   Enabling Sync will make sure that your document is synchronized with your desktop computer
during Hotsyncs.  Please see Chapter 2 on the conduit for more information on syncing.

Read-Only   Enabling Read-Only will make the document uneditable and hence read-only.

Private   Enabling Private will make this doc private (i.e., hideable) in WordSmith only.  

Delete…  By pressing the Delete button you can delete the document from within the details box.
Please note that this will only delete the document on your handheld.

With the Compression Title Tab of the Details dialog box selected, you will have the following options:

    

Compression status message   The message at the top of this dialog box lets you know whether
or not the document is uncompressed or compressed.  With WordSmith, docs are uncompressed only
when you edit and save (i.e., close) the doc.

39



Compress on HotSync   A checkbox next to this box indicates that the selected doc will  be
compressed during HotSyncs.

Compress Now If your document is uncompressed, you will see a Compress Now button.  Tap on
this button to compress your document.  Please note that you must save the doc before using this
option.

Delete…  By pressing the Delete button you can delete the document from within the details box.
Please note that this will only delete the document on your handheld.

Select Doc   This option explains how to select docs and that to select a doc without opening it, you can hold
the stylus over the doc name until the popup menu shown below appears. 

Doc Edit Menu 
The Edit menu for WordSmith docs is identical to the Memo Edit Menu described above.  Please see above for
assistance.

Doc Options Menu 
The Options menu for WordSmith docs is identical to the Memo Options Menu described above.  Please see
above for assistance.
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Document Editing
This section describes the features and menu options that are available when one is editing a doc.  To see these
features and menus, you need to launch WordSmith on your organizer, select the Doc Title Tab and open a doc
or create a new doc.  You can open a doc by tapping on the doc name in the Doc List View Screen or by tapping
the New button to create a new doc (please see Chapter 4 for more information).

Doc Edit Mode Screen Features

This section outlines the various features that are available in the doc Edit Mode screen (the screen you see
when you are in a doc in Edit Mode) shown below. 

Pop-Up Menus In addition to WordSmith’s many pull-down menus, WordSmith also has
some very handy pop-up menus for stylus users.  For example, if you are editing a doc, a pop-up
menu that lists the following: Cut, Copy, Bold Underline, Italics, Strikethrough, Larger, Smaller, and
Font is available.  You can access this pop-up menu by tapping and holding to select text, releasing,
and then tapping and holding the selected text. 

5
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Doc Name   The left side of the Title Bar indicates the name of the doc that you are editing.

Category   The right side of the Title Bar indicates the category 
that the doc is in.  In the example above, the category is Unfiled.
To change the doc’s category, simply tap on the category to get 
the category pop-up menu.  You can change the categorization 
of the doc by tapping on one of the listed categories or by 
selecting Edit Categories and creating a new category, deleting 
categories you no longer need, etc.

Done button   Tap the Done button to close and save the doc.

Edit button   Tap the Edit button to switch from Edit Mode to View Mode.  Tap it again to switch
back to Edit Mode.

Paragraph formatting button    Clicking on this button brings up the paragraph formatting
box (covers alignment, indenting, line spacing and page breaks).  For more information on this feature,
please see the discussion on the Format Menu -> Paragraph… below.

Justification button  This button indicates whether the memo is left, right or full justified or
centered.  Tap on the button to change the justification. Please note that full justified will not display on
your organizer but will display on your desktop computer.

Bold button   This button will be highlighted if enabled.  To turn on bold, simply click on the bold
button.  To disable, simply click on it again.  

Underline button   This button will be highlighted if enabled.  To turn on underline, simply click on
the Underline button.  To disable, simply click on it again.  

Italics button   This button will be highlighted if enabled.  To turn on italics, simply click on the
Italics button.  To disable, simply click on it again.  

Fonts button   This button indicates what the characters will look like and what Font type is being
used.  For example, if you are typing in Times New Roman, it will abbreviate that to Time and if you
have Bold enabled, the word Time will also be bold.

Arrow   Tap on the arrow in the lower right hand corner to hide the toolbar.  Tap on it again to get it
back.

Scrolling   The right side of the document has a scrollbar.  Use your stylus to move the cursor up and
down in the document.  Note how you can slowly scroll through the document by putting your cursor
on the up or down arrow or quickly move through the document by dragging the bar on the scrollbar.
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Doc Edit Mode Menus
This section describes the menu options that are available once one is editing a document.  To see these menus,
you need to launch WordSmith on your organizer, select Doc from the Title Bar and open a doc or create a new
doc.

Once you are inside of a doc, click on your organizer’s Menu icon (or FN+Phone for Palm Portable and
Stowaway keyboard users) and you will see the following menus:

   File

   Edit

   Format

   Options

Note on Special Keyboard Support and Shortcuts for Menu Items

Please note that you may use a Palm Portable or Stowaway keyboard to jump between the
menus and maneuver within menus.  Once the menus are open, simply use the arrow
keys to move between and within menus. Our goal with this application is to allow avid
keyboard users the ability to type memos and docs without having to use the stylus. In
addition, please note that  every menu item has an associated Graffiti  and keyboard
shortcut.  Please see Chapter 8 for more information.

Doc File Menu
The File menu for WordSmith docs has the following options:

Save / Save As…  This option allows you to save your doc without exiting it or to change the name of the
saved file.  It also lets you compress when you save the doc and to save a WordSmith doc (i.e., a doc with rich
text in it) as a plain text doc (and thus, viewable in other doc viewers).

Rename…  This option allows you to rename your doc.  
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Delete Doc…  This option will let you delete the doc that you are in.  Please note that this option will delete
the document from your handheld but not from the desktop.

Abandon Changes   This option will let you close the doc without saving any  of the changes that you made
during the editing session.

Beam Doc   This option will let you beam the doc that you are in.

Print Doc…  This option will let you print your WordSmith doc with the assistance of a supported printing
utility, such as PrintBoy by Bachmann Software (www.bachmannsoftware.com).

Close   This option will let you save and close the doc that you are in.  As an alternative to using this menu
option, you can simply hit the Done button to save and close your doc.

Details…  Tap on Details to open the Details dialog box shown below.  

This dialog box provides (1) certain general information on the doc and provides you the opportunity to change
certain attributes of the doc and (2) compression information.  With the General Title Tab selected, you will
have the following options:

Name   Indicates the current name of the document.  You may change the name by inputting a new
name and clicking OK.

Category   Shows the category the doc is saved under and allows you to change the category by
clicking on the arrow to the left of the category name.  

Sync   Enable Sync if you want the document to be synchronized with your desktop computer during
synchronization  operations.   Please  see  Chapter  2  on  the  conduit  for  more  information  on
synchronization.

Read-Only   Enabling Read-Only will make the document uneditable and hence read-only.

Private   Enabling Private will make this doc private (i.e., hideable) in WordSmith only.

Delete…   By pressing the Delete button you can delete the document from within the details box.
Please note that this will only delete the document on your handheld.

With the Compression Title Tab of the Details dialog box selected, you will have the following options:
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Compression status message   The message at the top of this dialog box lets you know whether
or not the document is uncompressed or compressed.  With WordSmith, you have the option of
compressing your docs during synchronization.  

Compress on HotSync A checkbox next  to  this  box  indicates  that  the  selected doc will  be
compressed during HotSyncs.

Compress Now If your document is uncompressed, you will see a Compress Now button.  Tap on
this button to compress your document. Please note that you must save the doc before using this
option.

Delete…  By pressing the Delete button you can delete the document from within the details box.
Please note that this will only delete the document on your handheld.

Go To Top   This option takes your cursor to the top of the doc.

Go To Bottom   This option takes your cursor to the bottom of the doc.

Go To Paragraph…  This option opens the box shown below in your doc (kind of like your television’s, picture
in picture feature) and provides you with the first few words of each paragraph in your document.  This way you
can easily see which paragraph you would like to jump to.  

Use the arrows on the upper right hand and lower right hand corner to move through the document a
paragraph at a time.  Alternatively, you can scroll through the list by using the Cmd + arrow keys. Click on the
paragraph that you would like to jump to. To close this feature, simply tap outside of the box.
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Go To / Count   This option enables the Go To / Count dialog box shown below.

This feature allows you to be pretty specific about where in the document you want to go.  You can choose from
going to a certain paragraph of the document, a certain character or percentage through the document.  Don’t
waste too much time fretting over which method to use… once you fill in any of the 3, the other categories will
automatically be filled in…so, if you said you wanted to go to paragraph 4 of your document, the program
automatically fills in what character and percent of the document paragraph 4 represents.

Paragraph   This option not only lets you jump to a certain paragraph in the document, it also lets
you know how many paragraphs are in the document.  In addition, by clicking on the arrow to the right
of Paragraph, you can see the first few words of each paragraph in your document and go to a
paragraph by selecting the first few words of it.  To close the paragraph content box, simply tap
outside of the box. 

Character   This option not only lets you jump to a certain character in the document, it also lets you
know how many characters are in the document.  

Percent   This option lets you pick how far into the document you would like to go… 26% anyone?

Words   This simply tells you the number of words in the doc. 

Top Button   Tap this button as an alternative way to get to the top of the doc.

Bottom Button   Tap this button as an alternative way to get to the bottom of the doc.

Doc Edit Menu

The Edit menu for WordSmith docs has the following options:

Undo   This option lets you undo multiple edits that you have made to the doc.

Redo   This option lets you redo the undo that you made to the doc.  You can also do multiple redo’s.

Cut   This option lets you cut or delete selected portions of your doc.  To select text, tap and hold your stylus to
the left of the text that you would like to select and drag it to the right of the end of the text that you want to
select.
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Copy   This option lets you copy selected portions of your doc.  To select text, tap and hold your stylus to the
left of the text that you would like to select and drag it to the right of the end of the text that you want to select.

Paste   This option lets you paste text that has been cut or copied from elsewhere in the doc or from another
doc or application on your organizer.  Please note that when you paste from another doc or application, you can
only paste 1,000 characters at a time (this is due to limitations of the Palm OS).  To paste, tap your stylus on the
location where you want to move the text and then select Paste from the Edit Menu.  

Multi-Paste…  Unlike standard paste, multi-paste allows you to do a paste
of any of your
last 10 'Cut or Copy' commands.  Just select multi-paste from the menu and a list appears with the 
beginning text of each 'Copy'.  Select the one you want and it will be pasted into the document.  

Select All   This option enables you to select all of the text of your doc in 1 step.  This option is very handy
when you need to change the font and formatting of your doc and for cut/copy/paste operations.

Keyboard Tapping on Keyboard will bring up the onscreen keyboard on your organizer.  This is handy for
those times when you forget your graffiti or are without your Palm Portable or Stowaway keyboard. 

Graffiti Help…  This option provides you with a list of the Graffiti characters.  You can use the arrows in the
lower right hand corner to scroll through the characters.  Tap on the Done button when you are finished
refreshing your memory. Please see Chapter 8 for Graffiti shortcuts.

Keyboard Shortcuts…  This option provides you with a list of all of the keyboard shortcuts that you can use
in WordSmith.  These shortcuts were designed to work with the Palm Portable and Stowaway keyboards.  You
can use the arrows in the lower right hand corner to scroll through the characters.  Tap on the Done button
when you are finished refreshing your memory. Please see Chapter 8 for  more information on keyboard
shortcuts.

Find/Replace… This option lets you do a word or phrase search of the document.  Clicking on Find will bring
up the following Search This Document dialog box.  You can also access this by using the Find button on your
organizer’s screen (under the Calculator button).

Find Input the text that you want to search for. Tap OK to begin search

Replace If you enable this option, a line will appear for inputting text to replace the found text. Tap
OK to replace text.  

Match case Enable this option if you only want the search results to match the case of the search
term.

Whole word only Enable this option if you only want the search results to contain whole words (e.g.,
if you search for “sin,” you won’t get sincere as a result).

Search other applications Enable this to expand your search to include all of your searchable
applications (other than docs). 
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Doc Format Menu
The Format menu for WordSmith docs has the following options:

Bold   This option lets you enter bold text into a doc. You can tell that you have turned this option on by looking
at the Bold button (B) on the doc screen.  If it is highlighted, it is enabled. Click the Bold menu item or Bold
button again to turn off bold text.

Underline   This option lets you enter underlined text into a doc. You can tell that you have turned this option
on by looking at the Underline button (U) on the doc screen.  If it is highlighted, it is enabled. Click the
Underline menu item or Underline button again to turn off underline text.

Italics   This option lets you enter italicized text into a doc. You can tell that you have turned this option on by
looking at the Italics button (I) on the doc screen.  If it is highlighted, it is enabled. Click the Italics menu item or
Italics button again to turn off italicized text.

Left   This option lets you left justify text entered into your doc.   You can tell that you have turned this option
on by looking at the Justification button on the lower part of your screen.  If the text in the button is aligned to
the left, it is on.  You can switch to a different alignment by taping on the button or by tapping on a different
format menu item.  To left justify the whole doc, Select All (highlight all of the text) and then tap on Left.  To left
justify on a section of the doc, select the section and then tap on left.  To left justify newly entered text, tap on
left and type.   

Right   This option lets you right justify text entered into your doc.   Please see the instructions under Left
above for assistance on justifying text.

Center   This option lets you center text entered into your doc.   Please see the instructions under Left above
for assistance on justifying text.

Font…  This option will open the Font Selector dialog box shown below (the color screenshot on the left is
taken from a color device).  An alternative way to display the Font Selector dialog box is to tap on the Fonts
button in the lower right hand corner of your organizer’s screen. Note the Sample box in the lower right hand
corner that shows you what the font you have selected will look like. 

          

Font   Use the arrow to select a font. WordSmith has 3 default fonts:  Arial, Courier and Times New
Roman.  Additional fonts are added when docs that contain other than the default fonts are synced to
WordSmith.   Please note that the fonts do not actually display on the organizer but will display on the
desktop.

Size   Use the arrows to change the size of the Font.  You can choose a font as small as 4 and as large
as 127!  Please note that not all font sizes will display on your organizer but they will on your desktop.
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Show All Enable this option to show all fonts available in the 
WordSmith environment (master font database).  If not checked,
the Font feature (described above) will only show the fonts that 
are currently in use in the document.  Please see the description
of the Font feature above for information on how to add extra 
fonts.

Bold    Enable this option to enter bold text.

Underline   Enable this option to enter underlined text.

Italics   Enable this option to enter italicized text.

Superscript   Enable this option to enter superscript text.  Please note that currently the superscript
text will not display on your organizer (other than in the Sample box) but will display on your desktop
computer.

Subscript   Enable this option to enter strikethrough text.  Please note that currently the subscript
text will not display on your organizer (other than in the Sample box) but will display on your desktop
computer.

Strikethrough   Enable this option to enter strikethrough text.  

Color   Enable this option to choose the color of your font and background color.  Please note that this
feature is only available on color devices!   

Paragraph…  This option will open the paragraph formatting dialog box shown below.  An alternative way to
display this dialog box is to tap on the button to the right of the Edit button. This dialog box permits you to set
Alignment and Justification, Spacing and Page Breaks.  Tap on the push buttons to get to the screen that you
want.

Justification   To change the justification, click on the justification icon and select from among left,
center, right and full justification.

Indents…  You can toggle between setting your indentations in inches or centimeters.  Use the
arrows to adjust your left and right margins.  In addition, you may also set a first or hanging indent
(click the arrow next to None shown above).
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Spacing…   You can toggle between setting your spacing in points, inches or centimeters.  Use the
arrows to adjust the spacing before and after lines.

Line Spacing…   You can set the line spacing by tapping on the arrow.  Your choices are:  Single, 1.5
Lines, Double, Triple, Multiple (you enter the number of lines) and At Least or Exactly (for the last 2
options, you enter the number of points).

Page break options   With WordSmith you have 3 page break options.  Page break before causes a
page break before the paragraph.  Keep lines together prevents the paragraph from being split across
pages.  Lastly, Keep with next causes the paragraph to be kept  on the same page as the next
paragraph, even if this means that both paragraphs are moved to the next page.

Outline Level:  You can set outline levels by clicking on the arrow.  Your choices are Body text or
outline level 1-9.  Please note that these levels will not display on your handheld but will display on
your desktop.

Doc Options Menu
The Options menu for WordSmith docs has the following options:

Phone Lookup… This handy option lets you quickly look up a phone number and add it to your doc.  Simply
highlight the phone numbers you need and click on the Add button to add to your doc.  You can use the Look Up
feature or the arrows to search through your numbers.

Full Screen   This option lets you utilize every precious bit of your organizer’s screen for viewing or editing
your doc by hiding the Title Bar and toolbar.  To leave full screen mode, simply click on the small icon in the
upper right hand corner.  To stay in full screen mode but retrieve the Toolbar, click on the small arrow in the
lower right hand corner.  Click on the arrow again to hide the Toolbar. Please note that you can still use the pop-
up menus in full screen mode.

Register…  This option allows you register a trial version of WordSmith.  Simply tap on Register and input the
information requested on the Register dialog box.  For more information on registering, please see Chapter 9.

About…  Select About to see what version of WordSmith you are running.
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Memo Editing  
This chapter describes the features and menu options that are available once one is editing a memo.  To see
these features and menus, you need to launch WordSmith on your organizer, select the Memo Title Tab and
open a memo or create a new memo.  You can open a memo by tapping on the memo name in the Memo List
View Screen or by tapping the New button to create a new memo (please see Chapter 4 for more information).

Memo Edit Screen Features
This section outlines the various features that are available in the memo edit screen (the screen you see when
you are in a memo in Edit Mode) shown below.

Memo number   The left side of the Title Bar indicates what memo you are in by the memo’s number
(e.g., 4 of 6).  

Category   The right side of the Title Bar indicates the category that the memo is in.  In the example
above, the category is Unfiled. To change the memo’s category, simply tap on the category to get the
category pop-up menu.  You can change the categorization of the memo by tapping on one of the listed
categories or by selecting Edit Categories and creating a new category, delete categories you no
longer need, etc.

Done button Tap the done button to close and save the memo.
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Edit button   Tap the edit button to switch from Edit Mode to View Mode.  Tap it again to switch back
to Edit Mode.

Justification button    This button selects whether the memo is left or right justified or
centered.  Tap this button to change the justification. 

Bold button  This button will be highlighted if enabled.  To turn on bold, simply click on the Bold
button.  To disable, simply click on it again.  

Underline button  This button will be highlighted if enabled.  To turn on underline, simply click on
the Underline button.  To disable, simply click on it again.  

Italics button   This button will be highlighted if enabled.  To turn on italics, simply click on the
Italics button.  To disable, simply click on it again.  

Fonts button   This button indicates what the characters will look like.  For example, if you have
Bold enabled, the word Font will also be bold.

Arrow   Tap on the arrow in the lower right hand corner to hide the toolbar.  Tap on it again to get it
back.

Scrolling   The right side of the memo has a scrollbar.  Use your stylus to move the cursor up and
down in the memo.  Note how you can slowly scroll through the memo by putting your cursor on the
up or down arrow or quickly move through the memo by dragging the bar on the scrollbar.

Memo Edit Mode Menus
Once you are inside of a memo, click on your organizer’s Menu icon (or FN+Phone for Palm Portable and
Stowaway keyboard users) and you will see the following menus:

   Record

   Edit

   Format

   Option

Note on Special Keyboard Support and Shortcuts for Menu Items

. Please note that you may use a Palm Portable or Stowaway keyboard to jump between
the menus and maneuver within menus.  Once the menus are open, simply use the arrow
keys to move between and within menus. Our goal with this application is to allow avid
keyboard users the ability to type memos and docs without having to use the stylus. In
addition, please note that  every menu item has an associated Graffiti  and keyboard
shortcut.  Please see Chapter 8 for more information.

Memo Record Menu
The Record menu for WordSmith memos has the following options:
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New Memo   This option saves you a few clicks and allows you to open a new memo from within another
memo.  It will automatically save and close the memo that you are in and open a blank memo. 

Save as Doc…  As many of you are aware, the memos that you type on your organizers are subject to a
4,000-character ceiling.  If you hit this limit, WordSmith will automatically give you the option of saving the
memo as a doc.  Nevertheless, if you would like to convert your memo to a doc before hitting the ceiling, select
this option and enter a name for your new doc.  Please note that you will still have a copy of the memo in
WordSmith.

Delete Memo…  This option will let you delete the memo that you are in.  When you select this option, a
dialog box will ask you whether you want to save an archive copy on your PC.  To enable this archive option,
simply tap on the Save archive copy on Pc box and tap on OK.

Abandon Changes   This option will let you close the memo without saving any of the changes that you made
during the editing session.

Beam Memo…  This option will let you beam the memo that you are in.

Close   This option will let you save and close the memo that you are in.  As an alternative to using this menu
option, you can simply hit the Done button to save and close your memo.

Details…  This option will let you open the Memo Details dialog box.  This box indicates what category the
memo is saved under and allows you to change the memo category by clicking on the arrow to the left of the
category name.  In addition, by checking the Private box, you can make this memo private (i.e., hideable). 

Go To Top   This option takes your cursor to the top of the memo.

Go To Bottom   This option takes your cursor to the bottom of the memo.

Go To Paragraph…  This option opens the box shown below in your memo (kind of like your television’s,
picture in picture feature) and shows you the first few words of each paragraph in your memo.  

To select the paragraph you want to go to, tap on the first few words of the paragraph in the dialog box.  To
close this feature, simply tap outside of the box.
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Go To / Count…  This option enables the Go To / Count dialog box shown below.

This feature allows you to be pretty specific about where in the memo you want to go.  You can choose from
going to a certain paragraph of the memo, a certain character or percentage through the memo.  Don’t waste
too much time fretting over which method to use… once you fill in any of the 3, the other categories will
automatically be filled in…so, if  you said you wanted to go to paragraph 4 of  your memo, the program
automatically fills in what character and percent of the memo paragraph 4 represents.

Paragraph   This option not only lets you jump to a certain paragraph in the document, it also lets
you know how many paragraphs are in the document.  In addition, by clicking on the arrow to the right
of Paragraph, a box will pop-up that will let you see the contents of the first few words of each
paragraph in your memo.  You can select and go to a paragraph by clicking on its first few words in the
box.  To close the paragraph content box, simply tap outside of the box.

Character   This option not only lets you jump to a certain character in the document, it also lets you
know how many characters are in the document.  

Percent   This option lets you pick how far into the document you would like to go… 23% anyone?

 Words   This simply tells you the number of words in the memo.

Top Button   Tap this button as an alternative way to get to the top of the memo.

Bottom Button Tap this button as an alternative way to get to the bottom of the memo.

Memo Edit Menu
The Edit menu for WordSmith memos has the following options:

Undo   This option lets you undo multiple redos that you have made to the memo.

Redo   This option lets you redo multiple undos that you have made to the memo.
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Cut   This option lets you cut or delete selected portions of your memo.  To select text, tap and hold your stylus
to the left of the text that you would like to select and drag it to the right of the end of the text that you want to
select.

Copy   This option lets you copy selected portions of your memo.  To select text, tap and hold your stylus to the
left of the text that you would like to select and drag it to the right of the end of the text that you want to select.

Paste   This option lets you paste text that has been cut or copied from elsewhere in the memo.  To paste, move
your cursor to the location where you want to move the text and then select Paste from the Edit Menu.  

Multi-Paste…  Unlike standard paste, multi-paste allows you to do a paste
of any of your
last 10 “Copy” commands.  Just select multi-paste from the menu and a list appears with the beginning 
text of you last 10 “Copy” commands.  Select the one you want and it will be pasted into the document.  

Select All   This option enables you to select all of the text of your memo in one step.  This option is very handy
when you need to change the font and formatting of your memo and for cut/copy/paste operations.

Keyboard… Tapping on Keyboard will bring up the onscreen keyboard on your organizer.  This is handy for
those times when you forget your Graffiti or are without your Palm Portable or Stowaway keyboard.

Graffiti Help…  This option provides you with a list of the Graffiti characters.  You can use the arrows in the
lower right hand corner to scroll through the characters.  

Keyboard Shortcuts…  This option provides you with a list of all of the keyboard shortcuts that you can use
in WordSmith.  These shortcuts were designed to work with the Palm Portable and Stowaway keyboards.  You
can use the arrows in the lower right hand corner to scroll through the characters.  

Find/Replace… This option lets you do a word or phrase search of the document.  Clicking on Find will bring
up the following Search This Document dialog box.  You may also access this by clicking on the Find button on
your organizer (under the Calculator button).

Find   Input the text that you want to search for. Tap OK to begin search

Replace  If you enable this option, a line will appear for inputting text to replace the found text. Tap
OK to replace text.  

Match case  Enable this option if you only want the search results to match the case of the search
term.

Whole word only  Enable this option if you only want the search results to contain whole words
(e.g., if you search for “sin,” you don’t get sincere as a result).

Search other applications  Enable this expand your search outside of WordSmith to include all of
your searchable applications.
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Memo Format Menu
The Format menu for WordSmith memos has the following options:

Bold   This option lets you enter bold text into a memo. You can tell that you have turned this option on by
looking at the Bold button (B) on the memo screen.  If it is highlighted, it is enabled. Click the Bold menu item or
Bold button again to turn off bold text.

Underline   This option lets you enter underlined text into a memo. You can tell that you have turned this
option on by looking at the Underline button (U) on the memo screen.  If it is highlighted, it is enabled. Click the
Underline menu item or Underline button again to turn off underline text.

Italics   This option lets you enter italicized text into a memo. You can tell that you have turned this option on
by looking at the Italics button (I) on the memo screen.  If it is highlighted, it is enabled. Click the Italics menu
item or Italics button again to turn off bold text.

Left   This option lets you left justify text entered into your memo.   You can tell that you have turned this option
on by looking at the Justification button on the lower part of your screen.  If the text in the button is aligned to
the left, it is on.  You can switch to a different alignment by tapping on the button or by tapping on a different
format menu item.  To left justify the whole memo, Select All (highlight all of the text) and then tap on Left.  To
left justify on a section of the memo, select the section and then tap on left.  To left justify newly entered text,
tap on left and type.   

Right   This option lets you right justify text entered into your memo.   Please see the instructions under Left
above for assistance on justifying text.

Center   This option lets you center text entered into your memo.   Please see the instructions under Left above
for assistance on justifying text.

Font…  This option will open the Font Selector dialog box shown below.  An alternative way to display the Font
Selector dialog box is to tap on the Fonts button in the lower right hand corner of your organizer’s screen. Note
the Sample box in the lower right hand corner that shows you what the font you have selected will look like.
Font dialog box on the right is for color devices only.

   

Size   Use the arrows to change the size of the Font.  There are 3 font sizes available, Large, Normal
and Small.

Bold   Enable this option to enter bold text.
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Underline   Enable this option to enter underlined text.

Italics  Enable this option to enter italicized text.

Strikethrough   Enable this option to enter strikethrough text.  

Color Text and Background   Enable these options to select color for your text and background
(color devices only).
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Memo Option Menu
The Option menu for WordSmith memos has the following options:

Phone Lookup… This handy option lets you quickly look up a phone number and add it to your memo.
Simply highlight the phone numbers you need and click on the Add button to add to your memo.  You can use
the Look Up feature or the arrows to search through your numbers.

Full Screen  This option lets you utilize every precious bit of your organizer’s screen for viewing or editing
your memo by hiding the Title Bar and Toolbar.  To leave full screen mode, simply click on the small icon in the
upper left hand corner.  To stay in full screen mode but retrieve the toolbar, click on the small arrow in the lower
right hand corner.  Click on the arrow again to hide the toolbar.

Register…  This option allows you register a trial version of WordSmith.  Simply tap on Register and input the
information requested on the Register dialog box.  For more information on registering, please see Chapter 9.

About…  Select About to see what version of WordSmith you are using.
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Document Viewing

General Viewing
Many handheld computer users are familiar with Doc Viewers or E-book readers – these are the programs that
let  you  read  a  book  or  document  on  your  organizer.   WordSmith  takes  these  isolated  “viewer/reader”
applications and boosts their usefulness by coupling them with a powerful word processor and memo pad.
Doing a little research on the road and want to quote the author in a report you are writing?  Great… simply,
copy and paste text out of the book right into a report (i.e., another doc or memo).  

This section describes the features and menu options that are available when one is using WordSmith to view or
read docs or memos.  Of course, you can view or read when you are in Edit Mode, but View Mode has some
benefits, such as special scrolling options, that you will come to enjoy.  Also, View Mode can save you from a
costly, inadvertent deletion of important text!

A quick note before we begin coverage of the View Mode of WordSmith – since the features and menus of the
View Mode for docs and memos are virtually identical, we have decided to cover both modes in one section.  For
simplicity sake, we will just refer to document viewing in the remainder of this section, except where there is a
difference in features.

Note on Rotating Screen for Easy Viewing

WordSmith  users  who are  accustomed  to  flipping  their  organizer’s  90  degrees  and
reading the screen such that each line of text has more characters will be happy to hear
that this is doable with a freeware program called FlipHack.  For more information or to
download  a  free  copy  of  FlipHack,  please  visit::
http://www.byteswapped.com/palm...

View Mode Screen Features 

This section outlines the various features that are available in the View Mode. To get in View Mode, launch
WordSmith on your organizer, open a doc or create a new doc and change WordSmith to View Mode (if it isn’t
already in View Mode, you can do this by tapping on the Edit button). The figure below is a screenshot of the
Doc View Mode. 
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Document name   The left side of the Title Bar indicates the name of the document that you are
viewing.  (Note: in Memo View Mode, the left side of the Title Bar indicates what memo you are in by
the memo’s number (e.g., 1 of 4).  

Category   The right side of the Title Bar indicates the category that the doc is in.  In the example
above, the category is Unfiled. To change the doc’s category, simply tap on the category to get the
category pop-up menu.  You can change the categorization of the doc by tapping on one of the listed
categories or by selecting Edit Categories and creating a new category, delete categories you no
longer need, etc.

Done button  Tap the done button to close and save the doc.

View button  Tap the view button to switch from view mode to edit mode.  Tap it again to switch
back to view mode.

Stylus Drag button   This button turns on direct scrolling mode 
and lets the doc slide under your stylus as if you were dragging 
it up and down.

Auto-Scroll button   This button turns on auto-scroll mode.  With 
Auto-Scroll, you have two scrolling options.  If you tap and hold, 
the text will automatically scroll.  The farther you are from the 
center, the faster it scrolls up or down.  If you lift the stylus, the 
document will stop scrolling.  Alternatively, if you just tap near 
the top or bottom, it will scroll a whole page at a time.  If you 
tap near the center, it will scroll half of a page.  Please see the 
note below regarding Preferences.

Teleprompter button   This button turns on teleprompter mode.  
Just tap the stylus to the screen for variable speed – the closer 
to the center the slower it will scroll. Please see the note below 
regarding Preferences.
Arrow   Tap on the arrow in the lower right hand corner to hide the toolbar.  Tap on it again to get it
back.

Scrolling The right side of the screen has a scrollbar.  Use your stylus to move the cursor up and
down in the document.  Note you can slowly scroll through the memo by putting your cursor on the up
or down arrow or quickly move through the memo by dragging the bar on the scrollbar.

Note regarding Smooth Scrolling Preferences.  Please note that there are a few preferences that affect
how you View your documents.  To access the Preferences dialog box seen below, return to the Doc or Memo list
screen and open the Options menu and select Preferences.  Among other things, this option will allow you to
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enable left-handed support and to turn on or off smooth scrolling (turning off smooth-scroll will result in line by
line or somewhat “jerky” scrolling).

View Mode Menus
This section describes the menu options that are available once one is in View Mode.  To see these menus, you
need to launch WordSmith on your organizer, open a memo or doc and change from Edit Mode to View Mode (if
it isn’t already in View Mode, you can do this by tapping on the Edit button in the toolbar) and opening the doc
or memo you want to view.

Once you are inside of a doc or memo, click on your organizer’s Menu icon (or FN+Phone for Palm Portable and
Stowaway keyboard users) and you will see the following menus:

   For Docs:  File and Options

   For Memos:  Record and Options

Please note that the Doc View Mode File and Options menus are identical to the Doc Edit Mode File and Options
menus covered above.  Similarly, the Memo View Mode Record and Options menus are identical to the Memo
Edit Mode Record and Options menus.  For more information on these menus, please see Chapters 5 (Doc
Editing) and Chapter 6 (Memo Editing).
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Graffiti and Keyboard 
Shortcuts

Graffiti Shortcuts
The Graffiti shortcuts save you time by reducing the number of taps you need to make and the number of menus
you need to open to get the most of all of WordSmith’s features and menus.   To use a shortcut key, enter the
shortcut symbol (e.g., the slash with a dot at the end) by tapping in the lower left hand screen of the Graffiti box
and slashing upward in a northeast direction and entering the corresponding Graffiti shortcut.  For example, in
doc Edit Mode, to use the Copy command’s shortcut, enter in a slash and a C. WordSmith’s Graffiti shortcuts are
listed in the menus, to the right of the feature name. 

Keyboard Shortcut Keys
The following keyboard  shortcuts  were  developed exclusively  for  use  with  Palm Portable  and Stowaway
keyboards. To use a shortcut key, hold down the modifier key (usually, the Ctrl key) and press the keyboard key
corresponding to the command.  For example, to use the Bold command’s shortcut key, hold down Ctrl and
press b.  Please note that many shortcuts will also work on the GoType! Keyboard.

To see a list of the keyboard shortcut keys on your organizer, open a doc or memo in Edit Mode, open the Edit
menu and select Keyboard Shortcuts…

To speed up the key repeat rate (this is especially important for backspacing), tap the keyboard icon on your
organizer and drag the “Key Repeat Rate” slider to the right.

Note on Special Keyboard Support for Menus

. Please note that you may use a Palm Portable or Stowaway keyboard to jump between
the menus and maneuver within menus.  Once the menus are open, simply use the arrow
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keys to move between and within menus. Our goal with this application is to allow avid
keyboard users the ability to type memos and docs without having to use the stylus.  

General Keyboard Shortcuts

Ctrl-c = copy
Ctrl-x = cut
Ctrl-v = paste
Ctrl-s = save/save as
Ctrl-z = undo
Ctrl-y = redo
Ctrl-f = find
Ctrl-b = bold
Ctrl-u = underline
Ctrl-i = italics
Ctrl-l = left align
Ctrl-e = center
Ctrl-r = right align
Ctrl-j = full justify (preserved, but only displayed on the desktop)
Ctrl-g = go to
Ctrl-[ = shrink font
Ctrl-] = grow font
Ctrl-m = left indent+
Ctrl-M = left indent -
Ctrl-t = hanging indent +
Ctrl-T = hanging indent -
Ctrl-d = Font dialog
Ctrl-P = Also font dialog
Ctrl-S = Paragraph style dialog
Ctrl- -- = Strikethrough
Ctrl-= = Subscript (preserved, but only displayed on the desktop)
Ctrl-+ = Superscript (preserved, but only displayed on the desktop)
Left/right = Move one character left/right
Ctrl-left/right = Move a word left/right
Cmd-left/right = Go to beginning/end of line
Up/down = Move one line up/down
Ctrl-up/down = Go to up/down a paragraph
Fn-up/down = Go up/down a page
Cmd-up/down = Go to top/bottom of document
Ctrl-backspace = Delete previous word.
Ctrl-delete = Delete next word.

Text Selection Keyboard Shortcuts 
The following keyboard shortcuts allow you to rapidly select text:

Left/right+Shift = Select one character left/right
Ctrl-left/right+Shift = Select a word left/right
Cmd-left/right+Shift = Select to beginning/end of line
Up/down+Shift = Select one line up/down
Ctrl-up/down+Shift = Select up/down a paragraph
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Fn-up/down+Shift = Select up/down a page
Cmd-up/down+Shift  = Select top/bottom of document
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Registering and Technical Support

Registering 
If would like to register (i.e., purchase) WordSmith, please visit the purchase center at Blue Nomad’s website:
www.bluenomad.com or write to sales@bluenomad.com for ordering information and availability.  

When you purchase the registered version of WordSmith, you will be emailed a registration code.   

If you are downloading the application for the first time, simply enter the registration code when prompted for
it.  Alternatively, if you already have a trial copy of the application installed, simply launch WordSmith, open
menus -> Options -> Register… and input the information requested on the Register dialog box.  

Currently, WordSmith may be purchased online, by mail or fax or by sending in a purchase order.  Please note
that Blue Nomad’s license policy is that one license entitles a user to use the software on one organizer. 

Site Licenses and Special Discounts
In addition, volume discounts, site licenses, education and government discounts are available. Please contact
our sales department (sales@bluenomad.com) or visit the Blue Nomad website for details. 

Updates & Email Address Changes
If you are a registered user and your email address changes, please let us know so that we can continue to send
you updates and bug fixes to our software.  When sending us an email address change notification, please
include your full name, old email address and new address to expedite.  Or, if you think that you may have
missed an update, please let us know by sending us your full name and email address. Please send all such
requests to upgrades@bluenomad.com .

Technical Support 
If  you  have  a  question  that's  not  answered  in  this  document,  please  visit  the  support  center  at
www.bluenomad.com to review our frequently  asked questions (FAQs) section. We will  constantly  be
updating our FAQs and our website to better serve you.

If  you  don’t  find  your  question  in  the  FAQs,  please  email  your  technical  support  question  to:
support@bluenomad.com.  We  make  every  effort  to  answer  email  inquiries  within  one business  day
(California time). 

What to include with your support inquiry?

Please include the following with your question:

 9

80

mailto:support@bluenomad.com
http://www.bluenomad.com/
mailto:upgrades@bluenomad.com
mailto:sales@bluenomad.com
mailto:sales@bluenomad.com
http://www.bluenomad.com/


  HotSync Log.  To generate a HotSync log, run a HotSync.  Then, open the Palm desktop    software,
select HotSync and then select view HotSync log.  Copy the log and paste it into your email inquiry. 

  Information on your organizer.   Please provide us with information on what organizer, Palm OS
version and HotSync version you are using.  

 Information on your computer.  Please provide us with information on what version of Windows
and Microsoft Word you are using.

 Please provide a detailed description of the problem.    For example, if you are experiencing
an error, please give us the exact error and the scenario when the error occurred.  

Thanks for your cooperation!

Email Address Changes
If you are a registered user and your email address changes, please let us know so that we can continue to send
you updates and bug fixes to our software.  When sending us an email address change notification, please
include your full name, old email address and new address to expedite.  Please send all such requests to
upgrades@bluenomad.com.

WordSmith is a trademark of Blue Nomad, LLC.

Palm Computing is a registered trademark and the Palm Computing platform Platinum logo is a trademark of
Palm Computing, Inc., 3Com or its subsidiaries.  

All other companies and products listed herein are trademarks or registered trademarks of their respective
holders.
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